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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging the
product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal injury,
catastrophic loss of data, or extensive damage to the product.
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1 Product basics

● Product comparison

● Supported operating systems

● Serial number and model number location

● Control panel layout

● Product hardware setup and software installation
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Product comparison
Model Features

HP Color LaserJet M750n ● 100-sheet multipurpose input tray (Tray 1)

● 250-sheet input tray (Tray 2)

● 500-sheet input tray (Tray 3)

● 300-sheet, face-down output bin

● Hi-Speed USB 2.0 port

● HP Jetdirect embedded print server for connecting to a 10/100/1000Base-TX network

● 1 gigabyte (GB) of random access memory (RAM)

● USB port on the control panel for walk-up printing

HP Color LaserJet M750dn ● 100-sheet multipurpose input tray (Tray 1)

● 250-sheet input tray (Tray 2)

● 500-sheet input tray (Tray 3)

● 300-sheet, face-down output bin

● Hi-Speed USB 2.0 port

● HP Jetdirect embedded print server for connecting to a 10/100/1000Base-TX network

● 1 GB of RAM

● USB port on the control panel for walk-up printing

● Automatic two-sided printing

HP Color LaserJet M750xh ● 100-sheet multipurpose input tray (Tray 1)

● 250-sheet input tray (Tray 2)

● 500-sheet input tray (Tray 3)

● HP 3x500-sheet paper feeder (Trays 4, 5, and 6)

● 300-sheet, face-down output bin

● Hi-Speed USB 2.0 port

● HP Jetdirect embedded print server for connecting to a 10/100/1000Base-TX network

● 1 GB of RAM

● USB port on the control panel for walk-up printing

● Automatic two-sided printing

● HP Encrypted High Performance Hard Disk
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Supported operating systems
IMPORTANT: The list of supported operating systems applies to the Windows PCL 6, UPD PCL 6, UPD PCL 5,
UPD PS, and Mac print drivers and to the in-box software installation CD. For a current list of supported
operating systems, go to www.hp.com/support/colorljM855 for HP's all-inclusive help for your product. If
you are located outside the US, go to www.hp.com/support, select a country/region, and then click Drivers &
Software. Enter a product name or number. In the Download Options area, click Drivers, Software &
Firmware. Click the operating system version, and then click the Download button.

Mac installer software is not included on the CD. The CD provides steps to download the Mac installer
software from www.hp.com.Some Mac products no longer include an internal drive to install new software
from CDs. If you do not have an external Apple USB SuperDrive, the steps to download the Mac installer
software are as follows: Go to www.hp.com/support, select the country/region, and then click Drivers &
Software. Enter a product name or number. In the Download Options area, click Drivers, Software &
Firmware. Click the operating system version, and then click the Download button.

Windows XP SP3 or later, 32-bit and 64-bit.

NOTE: Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to provide
best-effort support for the discontinued XP operating system.

Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to provide best-effort
support for the discontinued XP operating system.

Windows Vista, 32-bit and 64-bit NOTE: Windows Vista Starter is not supported by the software installer or
the print driver.

Windows 7, 32-bit and 64-bit

Windows 8, 32-bit and 64-bit

NOTE: UPD PCL 5 is not supported for Windows 8.

Windows 2003 Server SP2 or later, 32-bit and 64-bit

NOTE: The software installer does not support the 64-bit version, but the print driver supports it.

NOTE: Microsoft retired mainstream support for Windows Server 2003 in July 2010. HP will continue to
provide best-effort support for the discontinued Server 2003 operating system.

Windows Server 2008, 32-bit and 64-bit

Windows Server 2008 R2, 64-bit

Windows Server 2012, 64-bit

NOTE: UPD PCL 5 is not supported for Windows Server 2012.

Mac OS X 10.6, 10.7 Lion, and 10.8 Mountain Lion

The HP Software Installer CD installs the HP PCL 6 discrete driver for Windows operating systems along with
other optional software.
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Serial number and model number location
The model number and serial number are listed on an identification label located on the left side of the
product. The serial number contains information about the country/region of origin, the product version,
production code, and the production number of the product.

Model name Model number

HP Color LaserJet M750n D3L08A

HP Color LaserJet M750dn D3L09A

HP Color LaserJet M750xh D3L10A
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Control panel layout
The control panel includes a color, graphical and text display, job-control buttons, and three light-emitting
diode (LED) status lights. 

1

89

3

7
6

2
4

5

1011
1 Control panel display Shows status information, menus, help information, and error messages.

2  Help button Provides detailed information, including animations, about product messages
or menus.

3 OK button Makes selections and resumes printing after continuable errors.

4  Up arrow button Navigates menus and text, and increases the values of numerical items in the
display.

 Down arrow button Navigates menus and text, and decreases the values of numerical items in the
display.

5  Back arrow button Navigates backward in nested menus.

6  Home button Opens and closes the menu structure.

7  Stop button Halts the current job, presents a choice to resume or cancel the current job,
clears paper from the product, and clears any continuable errors that are
associated with the halted job. If the product is not printing a job, pressing the
Stop button pauses the product.

8

Attention light

The Attention light indicates that the product has a condition that requires
intervention. Examples include an empty paper tray or an error message on the
display.

9

Data light

The Data light indicates that the product is receiving data.

10

Ready light

The Ready light indicates that the product is ready to begin processing any job.

11 Walk-up USB port Connect a USB flash drive for walk-up printing.

NOTE: To enable and use the walk-up USB port, see the online user guide at
www.hp.com/support/colorljM750.
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional
instructions, go to HP support on the Web.

In the US, go to www.hp.com/support/colorljM750 for HP's all-inclusive help for your product.

Outside the US, follow these steps:

1. Go to www.hp.com/support.

2. Select your country/region.

3. Click Product Support & Troubleshooting.

4. Enter the product name, and then select Search.

Select your product to find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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2 Control panel menus

● Navigate the Administration menu

● Print information pages
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Navigate the Administration menu
The Administration menu has several sub-menus, which are listed when you select the menu and then press
the OK button. To return to the previous level, press the Back button.

1. At the control panel, press the Home button .

2. Use the arrow buttons to navigate to the Administration menu, and then press the OK button.

NOTE: You can perform basic product setup by using the Administration menu. Use the HP Embedded Web
Server for more advanced product setup. To open the HP Embedded Web Server, enter the product IP address
or host name in the address bar of a Web browser.
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Print information pages
Information pages provide details about the product and its current configuration. Use the following
procedures to print commonly used information pages:

Print the menu map
The menu map report presents the entire structure of the Administration menu so you can identify how to
navigate to any option.

1. At the control panel, press the Home button .

2. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

3. Select the Administration Menu Map item.

4. Select the print item.

5. Press the OK button to print the page.

Print the configuration report
The configuration report lists the current product settings and installed options. Use this report to find the
product IP address or host name, the current firmware version, and information about network protocols.

1. At the control panel, press the Home button .

2. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

3. Select the Configuration Pages item.

4. Press the OK button to print the report. The report consists of several pages.

NOTE: The product IP address or host name is listed on the Jetdirect Page.
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3 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types and tray capacity

● Load paper trays

● Configure trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this user
guide. Paper or print media that does not meet these guidelines might cause poor print quality, increased
jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do not use
paper or print media made for inkjet printers. HP Company cannot recommend the use of other brands of
media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels, or
other variables over which HP has no control.

CAUTION: Using paper or print media that does not meet HP's specifications might cause problems for the
product, requiring repair. This repair is not covered by the HP warranty or service agreements.

Special paper guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory results.
When using special paper or print media, be sure to set the type and size in the printer driver to obtain the
best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise dots. HP
laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that are
approved for use in laser printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no exposed
backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat surface
after removing them from the
product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.
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Media type Do Do not

Heavy paper ● Use only heavy paper that is
approved for use in laser printers and
meets the weight specifications for
this product.

● Do not use paper that is heavier than
the recommended media
specification for this product unless it
is HP paper that has been approved
for use in this product.

Glossy or coated paper ● Use only glossy or coated paper that
is approved for use in laser printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type and size
Change the paper size and type (Windows)

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.

Change the paper size and type (Mac)

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before
printing.

Table 3-1  Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 Tray 3, optional
trays 4, 5, and 6

Letter1 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

A41 210 x 297 mm (8.27 x 11.69 in)

RA4 215 x 305 mm (8.47 x 12 in)

SRA4 225 x 320 mm (8.86 x 12.2 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

A3 297 x 420 mm (11.69 x 16.54 in)

A5 148 x 210 mm (5.83 x 8.27 in) 2

A6 105 x 148 mm (4.13 x 5.83 in)   

B4 (JIS) 257 x 364 mm (10.12 x 14.33 in)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)

B6 (JIS) 128 x 182 mm (5.04 x 7.17 in)   

8k 270 x 390 mm (10.6 x 15.4 in)

260 x 368 mm (10.2 x 14.5 in)

273 x 394 mm (10.75 x 15.5 in)

16k 184 x 260 mm (7.24 x 10.24 in)

195 x 270 mm (7.68 x 10.63 in)

197 x 273 mm (7.75 x 10.75 in)

8.5 x 13 (Folio) 216 x 330 mm (8.5 x 13 in)

Index card 76 x 127 mm (3 x 5 in)3   

101.6 x 152 mm (4 x 6 in)   

127 x 177.8 mm (5 x 7 in)   

127 x 203 mm (5 x 8 in)   
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Table 3-1  Supported paper and print media sizes (continued)

Size Dimensions Tray 1 Tray 2 Tray 3, optional
trays 4, 5, and 6

Statement 139.7 x 216 mm (5.5 x 8.5 in)   

10 x 15 cm 100 x 150 mm (3.9 x 5.9 in)   

11 x 17
(Tabloid)

279 x 432 mm (11 x 17 in)

12 x 18 (Arch B) 305 x 457 mm (12 x 18 in)   

RA3 305 x 430 mm (12 x 16.9 in)   

SRA3 320 x 450 mm (12.6 x 17.7 in)   

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 312/320 x 470 mm (12.25/12.6 x
18.5 in)3

  

Minimum: 148 x 182 mm (5.8 x 7.1 in)

Maximum: 297 x 432 mm (11.7 x 17 in)

  

Minimum: 210 x 148 mm (8.3 x 5.8 in)

Maximum: 297 x 432 mm (11.7 x 17 in)

  

1 These sizes can be loaded in a rotated orientation in Tray 2, Tray 3, and optional Trays 4, 5, and 6.
2 A5 size is supported for Tray 3 only, as a custom size, with the long edge feeding into the product first. A5 size is not supported for

two-sided (duplex) printing from Tray 3.
3 Custom media width is limited to 312 mm (12.25 in). However, SRA3, which is 320 mm (12.6 in) wide, is supported. The maximum

printable image is 302 mm wide. With the required blank 5 mm margins on each side for printing, any media wider than 312 mm will
have its image centered and limited to 302 mm wide.

Table 3-2  Supported envelopes and postcards

Size Dimensions Tray 1 Tray 2

Envelope #9 98.4 x 225.4 mm (3.9 x 8.9 in)  

Envelope #10 105 x 241 mm (4.13 x 9.5 in)  

Envelope DL 110 x 220 mm (4.33 x 8.66 in)  

Envelope C5 162 x 229 mm (6.4 x 9 in)  

Envelope C6 114 x 162 mm (4.5 x 6.4 in)  

Envelope B5 176 x 250 mm (6.9 x 9.8 in)  

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)  

Postcard 100 x 148 mm (3.94 x 5.83 in)  

Double postcard 148 x 200 mm (5.83 x 7.87 in)
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Supported paper sizes for duplex printing
● Minimum: 148 x 182 mm (5.8 x 7.1 in)

● Maximum: 312/320 x 457 mm (12.3/12.6 x 18 in)

NOTE: Custom media width is limited to 312 mm (12.25 in). However, SRA3, which is 320 mm (12.6 in)
wide, is supported. The maximum printable image is 302 mm wide. With the required blank 5 mm
margins on each side for printing, any media wider than 312 mm will have its image centered and
limited to 302 mm wide.

NOTE: For automatic duplexing, do not load paper that is heavier than 120 g/m2 (32-lb bond). Use manual
duplexing to print on heavier paper.

ENWW Supported paper sizes 17



Supported paper types and tray capacity
Media type Dimensions1 Weight Capacity2

Paper, including the following
types:

● Plain

● Letterhead

● Color

● Preprinted

● Prepunched

● Recycled

Tray 1 minimum: 76 x 127 mm
(3 x 5 in)

Tray 1 maximum: 320 x 470 mm
(12.6 x 18.5 in)

Tray 2 minimum: 148 x 182 mm
(5.8 x 7.1 in)

Trays 3-6 minimum: 210 x 148 mm
(8.3 x 5.8 in)

Trays 2-6 maximum: 297 x
432 mm (11.7 x 17 in)

60 to 105 g/m2 (16 to 28 lb) Tray 1: up to 100 sheets of 75 g/
m2 (20 lb bond)

Tray 2: up to 250 sheets of 75 g/
m2 (20 lb bond)

Trays 3-6: up to 500 sheets of
75 g/m2 (20 lb bond)

Heavy paper Same as for paper Tray 1: up to 220 g/m2 (58 lb)

Trays 2-6: up to 120 g/m2 (32 lb)

Tray 1: up to 10 mm (0.4 in)

Tray 2: up to 25 mm (0.98 in) stack
height

Trays 3-6: up to 53 mm (2.1 in)
stack height

Cover paper Same as for paper Tray 1: up to 220 g/m2 (58 lb)

Trays 2-6: up to 120 g/m2 (32 lb)

Tray 1: up to 10 mm (0.4 in)

Tray 2: up to 25 mm (0.98 in) stack
height

Trays 3-6: up to 53 mm (2.1 in)
stack height

Glossy paper

Photo paper

Same as for paper Tray 1: up to 220 g/m2 (58 lb)

Trays 2-6: up to 160 g/m2 (43 lb)

Tray 1: up to 10 mm (0.4 in)

Tray 2: up to 25 mm (0.98 in) stack
height

Trays 3-6: up to 53 mm (2.1 in)
stack height

Transparencies A4 or Letter Thickness: 0.12 to 0.13 mm (4.7 to
5.1 mils)

Tray 1: up to 10 mm (0.4 in)

Labels3 A4 or Letter Thickness: up to 0.23 mm (9 mils) Tray 1: up to 10 mm (0.4 in)

Envelopes ● COM 10

● Monarch

● DL

● C5

● B5

Up to 90 g/m2 (24 lb) Tray 1: up to 10 envelopes

Postcards or index cards 76 x 127 mm (3 x 5 in)  Tray 1: up to 10 mm (0.4 in)

1 The product supports a wide range of standard and custom sizes of print media. Check the printer driver for supported sizes.
2 Capacity can vary depending on media weight and thickness, and environmental conditions.
3 Smoothness: 100 to 250 (Sheffield)

18 Chapter 3   Paper and print media ENWW



Load paper trays
Load Tray 1

1. Open Tray 1.  

2. Pull out the tray extension to support the paper.  

3. Load paper in the tray.  
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4. Make sure the stack fits under the tabs on the
guides and does not exceed the load-level
indicators.

 

5. Adjust the side guides so that they lightly touch
the paper stack but do not bend it.

 

Load Tray 2, Tray 3, and optional Trays 4, 5, and 6 with standard-size paper 

1. Open the tray.

NOTE: Do not open the tray while it is in use.
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2. Adjust the paper-length and paper-width guides
by squeezing the adjustment latches and sliding
the guides to the size of the paper being used.

 

3. Load paper into the tray. Check the paper to
verify the guides lightly touch the stack, but do
not bend it.

NOTE: To prevent jams, do not overfill the tray.
Be sure the top of the stack is below the tray full
indicator.

NOTE: If the tray is not adjusted correctly, an
error message might appear during printing or
the paper might jam.

 

4. Close the tray.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct, follow
the instructions on the control panel to change
the size or type.
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Load Tray 2, Tray 3, and optional Trays 4, 5, and 6 with custom-size paper 

1. Open the tray.  

2. Adjust the paper-length and paper-width guides
by squeezing the adjustment latches and sliding
the guides to the size of the paper being used.

 

3. Load paper into the tray. Check the paper to
verify the guides lightly touch the stack, but do
not bend it.
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4. Close the tray.  

5. The control panel prompts you to set the paper
size and type. Select the Custom setting, and
then configure the X and Y dimensions of the
custom paper size.

NOTE: See the label in the paper tray, or the
following illustration, to determine the X and Y
dimensions.

 

 

Load and print labels

Introduction

To print on sheets of labels, use Tray 2 or one of the optional 550-sheet trays. Tray 1 does not support
labels.

To print labels using the manual feed option, follow these steps to select the correct settings in the print
driver, and then load the labels into the tray after sending the print job to the printer. When using manual
feed, the printer waits to print the job until it detects the tray has been opened and closed.

Manually feed labels

1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print,
and then select the printer.

3. Click or tap the Paper/Quality tab.
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4. In the Paper size drop-down list, select the correct size for the sheets of labels.

5. In the Paper type drop-down list, select Labels.

6. In the Paper source drop-down list, select Manual feed.

NOTE: When using manual feed, the printer prints from the lowest-numbered tray that is configured
for the correct size of paper, so it is not necessary to specify a particular tray. For example, if Tray 2 is
configured for labels, the printer will print from Tray 2. If Tray 3 is installed and configured for labels,
but Tray 2 is not configured for labels, the printer will print from Tray 3.

7. Click the OK button to close the Document Properties dialog box.

8. In the Print dialog box, click the OK button to print the job.

9. Load sheets of labels face-up with the top of the sheet toward the right side of the printer.

Tray and bin capacity

Tray or bin Paper type Specifications Quantity

Tray 1 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2 (58 lb)
bond

Maximum stack height: 10 mm (0.39 in)

Equivalent to 100 sheets of 75 g/m2

(20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond to 90 g/
m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum 0.102 mm (0.004 in) thick Maximum stack height: 10 mm (0.39 in)

Transparencies Minimum 0.102 mm (0.004 in) thick Maximum stack height: 10 mm (0.39 in)

Up to 50 sheets

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2 (58 lb)
bond

Maximum stack height: 10 mm (0.39 in)

Up to 50 sheets

24 Chapter 3   Paper and print media ENWW



Tray or bin Paper type Specifications Quantity

Tray 21 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2 (59 lb)
bond

Maximum stack height: 25 mm (.98 in)

Equivalent to 250 sheets of 75 g/m2

(20 lb) bond

Transparencies Minimum 0.102 mm (0.004 in) thick Maximum stack height: 25 mm (.98 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2 (58 lb)
bond

Maximum stack height: 25 mm (.98 in)

Tray 3 and optional Trays 4, 5, and
61

Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2 (59 lb)
bond

Equivalent to 500 sheets of 75 g/m2

(20 lb) bond

Maximum stack height: 53 mm (2.1 in)

Transparencies Minimum 0.102 mm (0.004 in) thick Maximum stack height: 53 mm (2.1 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2 (58 lb)
bond

Maximum stack height: 53 mm (2.1 in)

Output bin Paper  Up to 300 sheets of 75 g/m2 (20 lb) bond

1 Trays 2, 3, 4, 5, and 6 can print on bond paper heavier than 220 g/m2 (59 lb) in some circumstances, but HP does not guarantee
results.

Paper orientation for loading trays
If you are using paper that requires a specific orientation, load it according to the information in the following
tables.

NOTE: The Alternative Letterhead Mode and Image Rotation settings affect the way you load letterhead or
preprinted paper. The following information depicts the default setting.

Paper orientation for loading Tray 1

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face down

Top edge toward the back of the product
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Paper type Image orientation Duplex mode How to load paper

Automatic 2-sided printing Face up

Top edge toward the back of the product

Landscape 1-sided printing Face down

Top edge toward the back of the product

Automatic 2-sided printing Face up

Top edge toward the back of the product

Prepunched Portrait or landscape 1- or 2-sided printing Face down

Holes toward the right side of the tray

Envelopes Short edge of the envelope
feeding into the product

1-sided printing Face down

Top edge toward the back of the product
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Paper orientation for loading Tray 2, Tray 3, or optional Trays 4, 5, and 6

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face up

Top edge at the back of the tray

Automatic 2-sided printing Face down

Top edge at the back of the tray

Landscape 1-sided printing Face up

Top edge toward the right side of the tray

Automatic 2-sided printing Face down

Top edge toward the right side of the tray

Prepunched Portrait 1-sided printing Face up

Holes toward the left side of the tray

Automatic 2-sided printing Face down

Holes toward the right side of the tray
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or media type for a print job through the printer driver or a software
program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not appear if you are printing from Tray 1, and it is configured for the Any Size and
Any Type settings. In this situation, if the print job does not specify a tray, the product prints from Tray 1,
even if the paper size and type settings in the print job do not match the paper loaded in Tray 1.

Configure a tray when loading paper
1. Load paper in the tray. Close the tray if you are using Tray 2, 3, 4, 5, or 6.

2. The tray configuration message appears.

3. Press the OK button to accept the size and type, or press Modify and choose a different paper size or
paper type.

4. To modify the tray size configuration, press the down arrow  to highlight the correct size, and then
press the OK button.

5. To modify the tray type configuration, press the down arrow  to highlight the correct type, and then
press the OK button.

Configure a tray to match print job settings
1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, the tray configuration message appears.

3. Load the tray with the specified type and size of paper, and then close the tray.

4. When the size and type confirmation messages appear, press the OK button to confirm the paper size
and type.

Configure a tray from the control panel
You can also configure the trays for type and size without a prompt from the product.

1. Press the Home button .

2. Open the following menu:

● Trays

3. Press the down arrow  to highlight the size or type setting for the desired tray, and then press the OK
button.

4. Press the up arrow  or the down arrow  to highlight the size or type. If you select a custom size,
select the unit of measure, and then set the X dimension and the Y dimension.
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5. Press the OK button to save your selection.

6. Press the Home button  to exit the menus.

Automatic paper sensing (auto-sense mode)
The automatic media type sensor functions when that tray is configured to the Any Type or plain type
setting. It also functions when the Print Mode setting for that tray is set to the Auto Sense Mode option.

After it has picked up paper from the tray, the product can detect overhead transparencies, paper weight, and
gloss level.

For more control, a specific type must be selected in the job or configured in a tray.

Auto-sense settings

Full sensing (Tray 1 only) For each sheet of paper that it picks up from the tray, the product detects light paper,
plain paper, heavy paper, glossy paper, tough paper, and transparencies.

Expanded sensing For the first few sheets of paper that it picks up from the tray, the product detects light
paper, plain paper, heavy paper, glossy paper, tough paper, and transparencies. The
product assumes the rest of the pages are of the same type.

Transparency only The product distinguishes between transparencies and non-transparencies.

Select the paper by source, type, or size
In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull media
when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print, Preferences, or
Print Properties dialog boxes in most software programs. Unless you change these settings, the product
automatically selects a tray using the default settings.

Source

To print by source, select a specific tray in the printer driver for the product to pull from. If you select a tray
that is configured for a type or size that does not match your print job, the product prompts you to load the
tray with the type or size of paper for your print job before printing it. When you load the tray, the product
begins printing.

Type and Size

● Printing by type or size causes the product to pull from the tray that is loaded with the correct type and
size of paper.

● Selecting paper by type rather than source helps protect special paper from accidental use.

● Using the wrong setting might result in unsatisfactory print quality. Always print by type for special
print media, such as labels or transparencies.

● Print by type or size for envelopes, if possible.
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● To print by type or size, select the type or size from the Page Setup dialog box, the Print dialog box, the
Preferences dialog box, or the Print Properties dialog box, depending on the software program.

● If you often print on a certain type or size of paper, configure a tray for that type or size. Then, when
you select that type or size as you print a job, the product automatically pulls paper from the tray that is
configured for that type or size.
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4 Print tasks

● Supported print drivers (Windows)

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Additional print tasks (Windows)

● Additional print tasks (Mac OS X)

● Store print jobs on the product

● Add a job-separator page (Windows)

● Mobile printing
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Supported print drivers (Windows)
Print drivers provide access to the product features and allow the computer to communicate with the product
(using a printer language). The following print drivers are available at www.hp.com/support/colorljM750.

HP PCL 6 driver ● Provided as the default driver on the in-box CD. This driver is automatically
installed unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs that
are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that
are based on PCL 5

HP Universal Print Driver (UPD)
The HP Universal Print Driver (UPD) for Windows is a single print driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software programs. It
is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need to
enable them manually.
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For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● To use this mode, download UPD from the Internet. Go to www.hp.com/go/upd.

● Use this mode if you are installing the driver for a single computer.

● It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and for
each product.

Dynamic mode ● To use this mode, download UPD from the Internet. Go to www.hp.com/go/upd.

● Dynamic mode allows you to use a single driver installation, so you can discover
and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.
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Print tasks (Windows)
Use a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Printing Shortcuts tab.  
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4. Select one of the shortcuts. Click the OK button
to close the Document Properties dialog box.

NOTE: When you select a shortcut, the
corresponding settings change on the other tabs
in the print driver.

 

5. In the Print dialog box, click the OK button to
print the job.
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Create printing shortcuts (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side of
the screen. If you adjust the settings and then
select a shortcut, all your adjustments are lost.
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5. Select the print options for the new shortcut.  

6. Click the Save As button.  
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7. Enter a name for the shortcut, and then click the
OK button.

 

8. Click the OK button to close the Document
Properties dialog box. In the Print dialog box,
click the OK button to print the job.
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Automatically print on both sides (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box. Click
the OK button to close the Document Properties
dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.
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Manually print on both sides (Windows) 

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides (manually) check
box. Click the OK button to print the first side of
the job.
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5. Retrieve the printed stack from the output bin,
and place it with the printed-side facing up in
Tray 1.

 

6. If prompted, touch the appropriate control panel
button to continue.
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Print multiple pages per sheet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Finishing tab.  

4. Select the number of pages per sheet from the
Pages per sheet drop-down list.
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5. Select the correct Print page borders, Page
order, and Orientation options. Click the OK
button to close the Document Properties dialog
box.

 

6. In the Print dialog box, click the OK button to
print the job.
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Select the page orientation (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Finishing tab.  
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4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select the
Rotate by 180 degrees option.

Click the OK button to close the Document
Properties dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.
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Select the paper type (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.
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7. Select the option for the type of paper you are
using, and click the OK button.

 

8. Click the OK button to close the Document
Properties dialog box. In the Print dialog box,
click the OK button to print the job.
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Print the first or last page on different paper (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Paper/Quality tab.  

4. In the Special pages area, click the Print pages
on different paper option, and then click the
Settings button.
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5. In the Pages in document area, select either the
First or Last option.

 

6. Select the correct options from the Paper source
and Paper type drop-down lists. Click the Add
button.

 

7. If you are printing both the first and last pages on
different paper, repeat steps 5 and 6, selecting
the options for the other page.
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8. Click the OK button.  

9. Click the OK button to close the Document
Properties dialog box. In the Print dialog box,
click the OK button to print the job.
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Scale a document to fit page size (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Effects tab.  

ENWW Print tasks (Windows) 53



4. Select the Print document on option, and then
select a size from the drop-down list.

Click the OK button to close the Document
Properties dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.
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Create a booklet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides check box.  
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5. In the Booklet layout drop-down list, click the
Left binding or Right binding option. The Pages
per sheet option automatically changes to 2
pages per sheet.

Click the OK button to close the Document
Properties dialog box.

 

6. In the Print dialog box, click the OK button to
print the job.
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Print tasks (Mac OS X)
Use a printing preset (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Presets menu, select the printing preset.

4. Click the Print button.

NOTE: To use print-driver default settings, select the standard option.

Create a printing preset (Mac OS X)
Use printing presets to save the current print settings for reuse.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
open a menu for which you want to change the print settings.

4. For each menu, select the print settings that you want to save for reuse.

5. In the Presets menu, click the Save As... option, and enter a name for the preset.

6. Click the OK button.

Automatically print on both sides (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select this product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.
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7. Retrieve the printed stack from the output bin and place it with the printed-side facing up in the input
tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each
sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Border menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the page orientation (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Click the icon that represents the page orientation that you want to use, and then click the OK button.

5. Click the Print button.

Select the paper type (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Print a cover page (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Cover Page menu.

4. Select where to print the cover page. Click either the Before Document button or the After Document
button.

58 Chapter 4   Print tasks ENWW



5. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.

6. Click the Print button.

Scale a document to fit page size (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Paper Handling menu.

4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select the size from
the drop-down list.

5. Click the Print button.

Create a booklet (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Open the menus drop-down list, and then click the Booklet Printing menu.

6. Click the Format Output As Booklet box, and select a binding option.

7. Select the paper size.

8. Click the Print button.
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Additional print tasks (Windows)
Cancel a print job (Windows)

NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it from the product control panel by following this procedure:

a. From the Home screen on the product control panel, touch the Stop button. The product pauses
the job, and the Job Status screen opens.

b. From the list on the touchscreen, touch the print job you want to cancel, and then touch the Cancel
Job button.

c. The product prompts you to confirm the cancellation. Touch the Yes button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing you
to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print spooler,
delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click Printers
and Faxes. Double-click the product icon to open the window, right-click the print job that
you want to cancel, and then click Cancel.

◦ Windows Vista: Click the Windows icon in the lower left corner of the screen, click Settings,
and then click Printers. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click the Windows icon in the lower left corner of the screen, and then click
Devices and Printers. Double-click the product icon to open the window, right-click the print
job that you want to cancel, and then click Cancel.

◦ Windows 8 (desktop applications) / Server 2012: Scroll to the bottom left corner of the
open desktop. Right-click the small window that displays in the lower-left corner. Select
Control Panel. Under Hardware and Sound select View devices and printers. Double-click
the product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel. If the print queue does not open directly, then under Printer Actions click
See what's printing.

Select the paper size (Windows)
1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Click the OK button.

6. In the Print dialog box, click the OK button to print the job.
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Select a custom paper size (Windows)
1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

6. Click the Save button, and then click the Close button.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.

Print watermarks (Windows)
1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and
then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise, the
watermark is printed on each page.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.
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Additional print tasks (Mac OS X)
Cancel a print job (Mac OS X)

NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it from the product control panel by following this procedure:

a. From the Home screen on the product control panel, touch the Stop button. The product pauses
the job, and the Job Status screen opens.

b. From the list on the touchscreen, touch the print job you want to cancel, and then touch the Cancel
Job button.

c. The product prompts you to confirm the cancellation. Touch the Yes button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing you
to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock. Highlight
the print job, and then click Delete.

Select the paper size (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

5. Click the Print button.

Select a custom paper size (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. From the Paper Size drop-down list, select the Manage Custom Sizes option.

5. Specify the dimensions for the page size, and then click the OK button.

6. Click the OK button to close the Page Setup dialog.

7. Click the Print button.

Print watermarks (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.
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3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Watermarks menu.

4. From the Mode menu, select the Watermark option.

5. From the Pages drop-down list, select whether to print the watermark on all pages or on the first page
only.

6. From the Text drop-down list, select one of the standard messages, or select the Custom option and
type a new message in the box.

7. Select options for the remaining settings.

8. Click the Print button.
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Store print jobs on the product
Create a stored job (Windows)

You can store jobs on the product so you can print them at any time.

1. From the software program, select the Print
option.

 

2. Select the product, and then click the Properties
or Preferences button.

 

3. Click the Job Storage tab.  
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4. Select a Job Storage Mode option.

● Proof and Hold: Print and proof one copy of
a job and then print more copies.

● Personal Job: The job does not print until
you request it at the product control panel.
For this job-storage mode, you can select
one of the Make Job Private/Secure options.
If you assign a personal identification
number (PIN) to the job, you must provide
the required PIN at the control panel. If you
encrypt the job, you must provide the
required password at the control panel.

● Quick Copy: Print the requested number of
copies of a job and then store a copy of the
job in the product memory so you can print it
again later.

● Stored Job: Store a job on the product and
allow other users to print the job at any time.
For this job-storage mode, you can select
one of the Make Job Private/Secure options.
If you assign a personal identification
number (PIN) to the job, the person who
prints the job must provide the required PIN
at the control panel. If you encrypt the job,
the person who prints the job must provide
the required password at the control panel.
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5. To use a custom user name or job name, click the
Custom button, and then enter the user name or
the job name.

Select which option to use if another stored job
already has that name:

● Use Job Name + (1-99): Append a unique
number to the end of the job name.

● Replace Existing File: Overwrite the existing
stored job with the new one.

 

6. Click the OK button to close the Document
Properties dialog box. In the Print dialog box,
click the OK button to print the job.

 

Create a stored job (Mac OS X)
You can store jobs on the product so you can print them at any time.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Job Storage menu.

4. In the Mode drop-down list, select the type of stored job.

● Proof and Hold: Print and proof one copy of a job and then print more copies.

● Personal Job: The job does not print until you request it at the product control panel. If you assign
a personal identification number (PIN) to the job, you must provide the required PIN at the control
panel.
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● Quick Copy: Print the requested number of copies of a job and then store a copy of the job in the
product memory so you can print it again later.

● Stored Job: Store a job on the product and allow other users to print the job at any time. If you
assign a personal identification number (PIN) to the job, the person who prints the job must
provide the required PIN at the control panel.

5. To use a custom user name or job name, click the Custom button, and then enter the user name or the
job name.

Select which option to use if another stored job already has that name.

Use Job Name + (1 - 99) Append a unique number to the end of the job name.

Replace Existing File Overwrite the existing stored job with the new one.

6. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a PIN. Type
a 4-digit number in the Use PIN to Print field. When other people attempt to print this job, the product
prompts them to enter this PIN number.

7. Click the Print button to process the job.

Print a stored job
Use the following procedure to print a job that is stored in the product memory.

1. On the product control panel, press the Home button.

2. Highlight the Retrieve from Device Memory item, and then press the OK button.

3. Highlight the name of the folder where the job is stored, and then press the OK button.

4. Highlight the name of the job, and then press the OK button. If the job is private or encrypted, enter the
PIN or password.

5. Adjust the number of copies, and then press the OK button to print the job.

Delete a stored job
When you send a stored job to the product memory, the product overwrites any previous jobs with the same
user and job name. If a job is not already stored under the same user and job name, and the product needs
additional space, the product might delete other stored jobs starting with the oldest. You can change the
number of jobs that the product can store from the General Settings menu on the product control panel.

Use this procedure to delete a job that is stored in the product memory.

1. On the product control panel, press the Home button.

2. Highlight the Retrieve from Device Memory option, and then press the OK button.

3. Select the name of the folder where the job is stored.

4. Select the name of the job, and then press the OK button

5. If the job is private or encrypted, enter the PIN or the password, and then press the OK button.

6. Highlight the Delete option, and then press the OK button.
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Add a job-separator page (Windows)
The product can insert a blank page at the beginning of each print job to make sorting jobs easier.

NOTE: The following procedure turns on this setting for all print jobs.

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):
Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):
Click Start, click Settings, and then click Printers.

Windows Vista: Click the Windows icon in the lower-left corner of the screen, click Control Panel, and
then click Printers.

Windows 7: Click the Windows icon in the lower-left corner of the screen, and then click Devices and
Printers.

Windows 8, Server 2012: Scroll to the bottom left corner of the open desktop. Right-click the small
window that displays in the lower-left corner. Select Control Panel. Under Hardware and Sound, select
View devices and printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.

4. Expand the Installable Options list.

5. In the Job Separator drop-down list, select the Enabled option.

6. Click the OK button.
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Mobile printing
HP offers multiple Mobile and ePrint solutions to enable wireless printing to an HP printer from a laptop,
tablet, smartphone, or other mobile device. To determine the best choice for your needs, go to www.hp.com/
go/LaserJetMobilePrinting (English only).

HP ePrint
Use HP ePrint to print documents by sending them as an email attachment to the product's email address
from any email enabled device.

NOTE: The product might require a firmware update to use this feature.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired or wireless network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with
HP Connected.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded Web
Server.

2. Click the HP Web Services tab.

3. Select the option to enable Web Services.

NOTE: Enabling Web Services might take several minutes.

4. Go to www.hpconnected.com to create an HP ePrint account and complete the setup process.

For more information, go to www.hp.com/go/support to review additional support information for your
product.

HP ePrint software
The HP ePrint software makes it easy to print from a desktop or laptop computer to any HP ePrint-capable
product. After installing the software, open the Print option from within your application, and then select HP
ePrint from the installed printers list. This software makes it easy to find HP ePrint-enabled products that
are registered to your HP Connected account. The target HP product can be at your desk or in a remote
location, such as a branch office or across the globe.

For Windows, the HP ePrint software also supports traditional direct IP printing to local network printers on
the network (LAN or WAN) to supported PostScript® products.

Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: The HP ePrint software is a PDF workflow utility for Mac, and is not technically a print driver. HP
ePrint software for Mac supports print paths only through HP Connected and does not support direct IP
printing to local network printers.
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AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the
product from an iPad, iPhone (3GS or later), or iPod touch (third generation or later) in the following
applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more
information about using AirPrint and about which HP products are compatible with AirPrint, go to
www.hp.com/go/airprint.

NOTE: AirPrint does not support USB connections.
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5 Color

● Adjust color

● Change the color options (Windows)

● Change the color theme for a print job (Windows)

● Change the color options (Mac OS X)

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab (Windows) or the Color Options or Color/Quality
Options menu (Mac) in the printer driver.

Automatic
Setting color options to the default or Automatic setting typically produces the best possible print quality for
color documents. The default or Automatic color adjustment option optimizes the neutral-gray color
treatment, halftones, and edge enhancements for each element in a document. For more information, see
the printer driver online Help.

Print in Grayscale
Select the Print in Grayscale option (Windows) or the Print Color as Gray option (Mac) from the printer driver
to print a color document in black and white. This option is useful for printing color documents that will be
photocopied or faxed. The product uses the monochrome mode, which reduces use of the color cartridges.
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Manual color adjustment
Manually set the color options to adjust the neutral-gray color treatment, halftones, and edge enhancements
for text, graphics, and photographs. To open the manual color adjustment options, follow one of these
procedures:

● Windows: From the Color tab, click the HP EasyColor check box to clear it, click the Manual button, and
then click the Settings button.

● Mac: Open the Advanced menu, or select the appropriate tab with the Color/Quality Options tab. Click
the HP EasyColor check box to clear it, and then enable the manual settings.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text, graphics,
and photographs.

Table 5-1  Manual color options

Setting description Setting options

Halftone

Halftone options affect the color output resolution and
clarity.

● Smooth provides better results for large, solid-filled print areas and
enhances photographs by smoothing color gradations. Select this
option when uniform and smooth area fills are the top priority.

● Detail is useful for text and graphics that require sharp distinctions
among lines or colors, or images that contain a pattern or a high level
of detail. Select this option when sharp edges and details are the top
priority.

Neutral Grays

The Neutral Grays setting determines the method for
creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using only
black toner. This guarantees neutral colors without a color cast. This
setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining all
four toner colors. This method produces smoother gradients and
transitions to other colors, and it produces the darkest black.

Edge Control

The Edge Control setting determines how edges are
rendered. Edge control has two components: adaptive
halftoning and trapping. Adaptive halftoning increases
edge sharpness. Trapping reduces the effect of color-
plane misregistration by overlapping the edges of
adjacent objects slightly.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is on.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Off turns off both trapping and adaptive halftoning.
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Use the HP EasyColor option
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology scans
documents and automatically adjusts photographic images in .JPEG or .PNG format. HP EasyColor
technology enhances the entire image at one time, rather than dividing it into several pieces, which results in
improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all documents and
automatically adjusts all photographic images with the same improved photographic results.

In the following example, the images on the left were created without using the HP EasyColor option. The
images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac Postscript
printer driver, so you do not need to make manual color adjustments. To disable the option so you can
manually adjust the color settings, open the Color tab in the Windows driver or the Color/Quality Options
tab in the Mac driver, and then click the HP EasyColor check box to clear it.
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Change the color options (Windows)
1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independently from other settings.
Click the Settings button to open the manual color-adjusment window.

NOTE: Changing color settings manually can impact output. HP recommends that only color
graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option
to print color documents for photocopying or faxing. Also use this option to print draft copies or to save
color toner.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.
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Change the color theme for a print job (Windows)
1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using a digital
mini lab. The product renders deeper, more saturated colors differently than with the Default
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color
space rather than sRGB. Turn off color management in the software program when using this
theme.

● None: No color theme is used.

● Custom Profile: Select this option to use a custom input profile to accurately control color output
(for example, to emulate a specific HP Color LaserJet product). Download custom profiles from
www.hp.com.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.
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Change the color options (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Color Options menu.

4. Click the HP EasyColor check box to clear it.

5. Open the Advanced settings.

6. Adjust the individual settings for text, graphics, and photographs.

7. Click the Print button.
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Match colors
The process of matching product output color to a computer screen is quite complex because printers and
computer monitors use different methods of producing color. Monitors display colors by light pixels using an
RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan, magenta, yellow, and black)
process.

Several factors can influence the ability to match printed colors to those on a monitor. These factors include:

● Paper

● Printer colorants (inks or toners for example)

● Printing process (inkjet, press, or laser technology for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Print drivers

● Computer operating system

● Monitors and monitor settings

● Video cards and drivers

● Operating environment (humidity for example)

For most situations, the best method for matching colors on the screen to the printed page is to print sRGB
colors.

Sample book color matching
The process for matching product output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if the inks used to create the
sample book are cyan, magenta, yellow, and black. These are usually referred to as process color sample
books.

Some sample books are created from spot colors. Spot colors are specially created colorants. Many of these
spot colors are outside of the range of the product. Most spot color sample books have companion process
sample books that provide CMYK approximations to the spot color.

Most process sample books will state which process standards were used to print the sample book. In most
cases they will be SWOP, EURO, or DIC. To get optimal color matching to the process sample book, select the
corresponding ink emulation from the product menu. If you cannot identify the process standard, use SWOP
ink emulation.

Print color samples
To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in the software program to describe the object you wish to match. Printed colors vary
depending on the paper type and the software program.

Use the following procedure to print color samples at the product using the control panel:
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1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● Reports

● Other Pages

3. Select either the RGB Samples or the CMYK Samples option, and touch the OK button.

PANTONE® color matching
PANTONE has multiple color matching systems. PANTONE MATCHING SYSTEM® is very popular and uses solid
inks to generate a wide range of color hues and tints.

NOTE: PANTONE Colors generated might not match PANTONE-identified standards. Consult current
PANTONE Publications for accurate color.
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6 Manage and maintain

● HP Embedded Web Server

● HP Utility for Mac OS X

● Use HP Web Jetadmin software

● Manage supplies and accessories

● Clean the product

● Software and firmware updates
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HP Embedded Web Server
Use the HP Embedded Web Server to manage printing functions from your computer instead of the product
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The
HP Embedded Web Server does not support IPX-based product connections. You do not have to have Internet
access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

How to access the HP Embedded Web Server (EWS)
1. From the Home screen on the product control panel, touch the Network  button to display the IP

address or host name.

2. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays on
the product control panel. Press the Enter key on the computer keyboard. The EWS opens.

To use the HP Embedded Web Server, your browser must meet the following requirements:

● Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later

● Mac OS X: Safari or Firefox using Bonjour or an IP address

● Linux: Netscape Navigator only

● HP-UX 10 and HP-UX 11: Netscape Navigator 4.7
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to check product status or to view or change product settings from your
computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based
network.

Open HP Utility
From the Finder, click Applications, click HP, and then click HP Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple  menu, click the System Preferences menu, and then click the Print
& Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features
The HP Utility toolbar is at the top of every page. It includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility in the Printers pane at
the left side of the screen.

● All Settings: Click this button to return to the HP Utility main page.

● Applications: Click this button to manage which HP tools or utilities appear in the Dock.

● HP Support: Click this button to open a browser and go to the HP support Web site for the product.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the
tasks that you can perform with HP Utility.

Menu Item Description

Information and Support Supplies Status Shows the product supplies status and provides links for ordering
supplies online.

 Device Information Shows information about the currently selected product.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 HP Connected Accesses the HP Connected Web site.
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Menu Item Description

 Update Firmware Transfers a firmware update file to the product.

NOTE: This option is available only after you open the View menu and
select the Show Advanced Options item.

 Commands Sends special characters or print commands to the product after the print
job.

NOTE: This option is available only after you open the View menu and
select the Show Advanced Options item.

Printer Settings Supplies Management Configures how the product should behave when supplies are nearing the
end of their estimated life.

 Trays Configuration Changes the default tray settings.

 Output Devices Manages settings for optional output accessories.

 Duplex Mode Turns on the automatic two-sided printing mode.

 Protect Direct Ports Disables printing over USB or parallel ports.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.

 Additional Settings Provides access to the HP Embedded Web Server.
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Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP products, including printers, multifunction products, and digital senders. This single solution
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging
environment — ultimately increasing business productivity by helping you save time, control costs, and
protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features.
Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about
upgrades.

ENWW Use HP Web Jetadmin software 85

http://www.hp.com/go/webjetadmin


Manage supplies and accessories
Print when a cartridge is at estimated end of life

Supplies messages

● <Color> <Supply> Low—where <Color> is the color of the supply, and <Supply> is the type of supply.
The product indicates when a supply level is low. The actual print cartridge life remaining can vary, but
the supply does not need to be replaced now. Consider having a replacement cartridge available to
install when the print quality is no longer acceptable. This alert appears only when <Color> <Supply>
Very Low is set to Stop.

● <Color> <Supply> Very Low. The product indicates when a supply level is very low. The actual print
cartridge life remaining can vary. Consider having a replacement cartridge available to install when the
print quality is no longer acceptable. Once an HP supply has reached very low, the HP Premium
Protection Warranty on that cartridge has ended.

Print-quality problems can occur when using a supply that is at its estimated end of life. The print cartridge
does not need to be replaced at this point in time unless the print quality is no longer acceptable.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them when you
install a new cartridge.

1. At the product control panel, press the Home button  .

2. Open the following menus:

● Administration

● Manage Supplies

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Settings

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the cartridge is very low, but to
continue printing.

NOTE: Using the Continue option allows printing beyond Very Low without customer interaction
and can result in unsatisfactory print quality.

● Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the cartridge.

● Select the Prompt to continue option to set the product to stop printing (including printing faxes)
and prompt you to replace the cartridge. You can acknowledge the prompt and continue printing.

If you select the Stop or Prompt to continue option, the product stops printing when it reaches the Very Low
threshold. When you replace the cartridge, the product automatically resumes printing.

Once an HP supply has reached Very Low, the HP Premium Protection Warranty on that supply has ended.
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Manage print cartridges

Toner cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.

HP policy on non-HP supplies

HP Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

NOTE: For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does not
affect either the warranty to the customer or any HP support contract with the customer. However, if product
failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner cartridge, HP will
charge its standard time and materials charges to service the product for the particular failure or damage.

HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel message
says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the
problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).

Recycle supplies

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information,
see the recycling guide that is included with each new HP supply item.

Data stored on the toner cartridge

The HP toner cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which
might include the following: the date when the toner cartridge was first installed, the date when the toner
cartridge was last used, the number of pages printed using the toner cartridge, the page coverage, the
printing modes used, any printing errors that might have occurred, and the product model. This information
helps HP design future products to meet our customers' printing needs.

The data collected from the toner cartridge memory chip does not contain information that can be used to
identify a customer or user of the toner cartridge or their product.

HP collects a sampling of the memory chips from toner cartridges returned to HP's free return and recycling
program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling are read and
studied in order to improve future HP products. HP partners who assist in recycling this toner cartridge might
have access to this data, as well.
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Any third party possessing the toner cartridge might have access to the anonymous information on the
memory chip.

Replacement instructions

Replace print cartridges

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M), cyan
(C), and yellow (Y).

CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water. Hot water
sets toner into fabric.

NOTE: Information about recycling used print cartridges is on the print-cartridge box.

1. Open the front door. Make sure that the door is
completely open.

 

2. Grasp the handle of the used print cartridge and
pull out to remove.

 

3. Store the used print cartridge in a protective bag.
Information about recycling used print cartridges
is on the print-cartridge box.

 

4. Remove the new print cartridge from its
protective bag.

NOTE: Be careful not to damage the memory
tag on the print cartridge.
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5. Grasp both sides of the print cartridge and
distribute the toner by gently rocking the print
cartridge.

 

6. Remove the orange protective cover from the
print cartridge.

CAUTION: Avoid prolonged exposure to light.

CAUTION: Do not touch the green roller. Doing
so can damage the cartridge.

 

7. Align the print cartridge with its slot and insert
the print cartridge until it clicks into place.

NOTE: The print cartridges go in at a slight
angle.

 

8. Close the front door.  
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Replace the toner collection unit

Replace the toner collection unit when the control panel prompts you.

NOTE: The toner collection unit is designed for a single use. Do not attempt to empty the toner collection
unit and reuse it. Doing so could lead to toner being spilled inside the product, which could result in reduced
print quality. After use, return the toner collection unit to HP’s Planet Partners program for recycling.

1. Open the rear door.  

2. Grasp the top of the toner collection unit and
remove it from the product.

 

3. Place the attached cap over the opening at the
top of the unit.
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4. Remove the new toner collection unit from its
packaging.

 

5. Insert the new unit into the product.  

6. Close the rear door.

To recycle the used toner collection unit, follow
the instructions included with the new toner
collection unit.

 

Clean the product
Over time, particles of toner and paper accumulate inside the product. This can cause print-quality problems
during printing. Cleaning the product eliminates or reduces these problems.

Clean the paper path and print-cartridge areas every time that you change the print cartridge or whenever
print-quality problems occur. As much as possible, keep the product free from dust and debris.

To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path
1. At the product control panel, press the Home button .

2. Open the following menus:
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● Device Maintenance

● Calibration/Cleaning

3. Press the down arrow  to highlight the Print Cleaning Page menu item, and then press the OK button.

4. Completion of the cleaning process depends on the product model:

● Non-duplex models: After the first side prints, reload the page into Tray 1 according the
instructions, and then press the OK button. After the second side prints, the task is complete.
Discard the printed page.

● Duplex models: After both sides print, the task is complete. Discard the printed page.
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Software and firmware updates
HP regularly updates features that are available in the product firmware. To take advantage of the most
current features, update the product firmware. Download the most recent firmware update file from the
Web:

● In the US, go to www.hp.com/support/colorljM750. Click Drivers & Software.

● Outside the US, go to www.hp.com/support. Select your country/region. Click Drivers & Software. Enter
the product name (for example, “LaserJet M575”), and then select Search.

ENWW Software and firmware updates 93

http://www.hp.com/support/colorljM750
http://www.hp.com/support


94 Chapter 6   Manage and maintain ENWW



7 Solve problems

● Self help

● Solve general problems

● Interpret control-panel messages

● Clear jams
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams.
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Solve general problems
If the product is not responding correctly, complete the steps in the following checklist, in order. If the
product does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves the
problem, you can stop without performing the other steps on the checklist.

Troubleshooting checklist
1. Make sure the product Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power is turned on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label that
is on the back of the product for voltage requirements.) If you are using a power strip and its
voltage is not within specifications, plug the product directly into the wall. If it is already plugged
into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make sure
that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection.

3. Check to see if any messages appear on the control-panel display. If any error messages appear, see
Interpret control-panel messages on page 99.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. See Print information pages on page 9. If the product is connected to a
network, an HP Jetdirect page also prints.

a. If the pages do not print, check that at least one tray contains paper.

b. If the page jams in the product, see Clear jams on page 106.

6. If the configuration page prints, check the following items:

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:

Windows: Click Start, click Settings, and then click Printers or Printers and Faxes. Double-click the
name of the product.

-or-

Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line for the
product.

ENWW Solve general problems 97



8. Verify that you have installed the printer driver for this product. Check the program to make sure that
you are using the printer driver for this product.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document does
not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with a
USB cable. Redirect the product to the correct port, or reinstall the software, selecting the new
connection type that you are using.

Factors that affect product performance
Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The printer I/O configuration

● The network operating system and configuration (if applicable)

● The printer driver that you are using
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Interpret control-panel messages
Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

Message type Description

Status messages Status messages reflect the current state of the product. They inform you of normal product operation and
require no interaction to clear them. They change as the state of the product changes. Whenever the
product is ready, not busy, and has no pending warning messages, the Ready status message appears if
the product is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the Ready
or status messages and remain until you press the OK button. Some warning messages are clearable. If the
Clearable Warnings menu in the Display Settings menu is set to the Job option, the next print job clears
these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing a jam.

Some error messages are auto-continuable. If the Continuable Events menu in the Display Settings menu
is set to the Auto-Continue option, the product continues normal operation after an auto-continuable error
message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the auto-
continue feature, and the button function takes precedence. For example, pressing the Stop button 
pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a product failure. You can clear some of these messages by turning
the product off and then on. These messages are not affected by the Auto-Continue setting. If a critical
error persists, service is required.

Control-panel messages
The product provides robust control panel messaging. When a message appears on the control panel, follow
the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention” message, and
no steps are shown to resolve the issue, turn the product off then on. Contact HP support if you continue to
experience issues with the product.

For additional information on a variety of topics, press the Help button  on the control panel.

Supplies status messages
The following table contains important information about supplies status messages.
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Table 7-1  Supplies status messages

Control panel message Description Recommended action

10.XX.YY Supply memory error The product cannot read or write to at least one
print cartridge memory chip or a memory chip
is missing from a print cartridge.

XX values

● 00 = Memory chip memory error

● 10 = Memory chip missing

YY values

● 00 = Black

● 01 = Cyan

● 02 = Magenta

● 03 = Yellow

Reinstall the print cartridge, or install a new
print cartridge.

Black Cartridge low The print cartridge is nearing the estimated end
of its useful life.

The product indicates when the print cartridge
level is low. The actual print cartridge life
remaining can vary. Consider having a
replacement cartridge available to install when
the print quality is no longer acceptable. The
print cartridge does not need to be replaced
now.

Black Cartridge very low The print cartridge is at the estimated end of its
useful life.

Print quality might decrease. Replace the print
cartridge when the print quality becomes
unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the print
cartridge at this time unless the print quality is
no longer acceptable. The actual print cartridge
life can vary.

Once an HP print cartridge has reached the very
low threshold, the HP Premium Protection
Warranty on that print cartridge has ended. All
print defects or print cartridge failures incurred
when an HP print cartridge is used in “continue
in very low” mode will not be considered to be
defects in materials or workmanship in the
print cartridge under the HP Print Cartridge
Warranty Statement.

Cyan cartridge low The print cartridge is nearing the estimated end
of its useful life.

The product indicates when the print cartridge
level is low. The actual print cartridge life
remaining can vary. Consider having a
replacement cartridge available to install when
the print quality is no longer acceptable. The
print cartridge does not need to be replaced
now.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Cyan cartridge very low The print cartridge is at the estimated end of its
useful life.

Print quality might decrease. Replace the print
cartridge when the print quality becomes
unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the print
cartridge at this time unless the print quality is
no longer acceptable. The actual print cartridge
life can vary.

Once an HP print cartridge has reached the very
low threshold, the HP Premium Protection
Warranty on that print cartridge has ended. All
print defects or print cartridge failures incurred
when an HP print cartridge is used in “continue
in very low” mode will not be considered to be
defects in materials or workmanship in the
print cartridge under the HP Print Cartridge
Warranty Statement.

Fuser Kit low The fuser kit is low. The actual supply life
remaining might vary. Consider having a
replacement fuser kit available to install when
print quality is no longer acceptable. You do not
need to replace the fuser kit at this time unless
print quality is no longer acceptable.

If print quality is no longer acceptable, replace
the fuser kit. Instructions are included with the
fuser kit.

Fuser Kit very low The fuser kit is very low. The actual supply life
remaining might vary. You do not need to
replace the fuser kit at this time unless print
quality is no longer acceptable. After an HP
supply has reached the very low threshold, the
HP Premium Protection Warranty for that
supply has ended.

If print quality is no longer acceptable, replace
the fuser kit. Instructions are included with the
fuser kit.

Incompatible <color> cartridge The indicated color print cartridge is not
compatible with this product.

Replace the print cartridge with one that is
designed for this product.

Incompatible fuser The fuser is not compatible with this product. CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before handling it.

1. Open the right door.

2. Remove the incompatible fuser.

3. Install the correct fuser.

4. Close the right door.

Incompatible supplies Print cartridges or other supply items are
installed that were not designed for this
product. The product cannot print with these
supplies installed.

Install supplies that are designed for this
product.

Incompatible Toner Collection Unit The toner collection unit is incompatible with
this product.

1. Open the rear door.

2. Remove the incompatible toner collection
unit.

3. Install the correct toner collection unit.

4. Close the rear door.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Incompatible transfer unit The transfer unit is incompatible with this
product.

1. Open the right door.

2. Remove the incompatible transfer unit.

3. Install the correct transfer unit.

4. Close the right door.

Magenta cartridge low The print cartridge is nearing the estimated end
of its useful life.

The product indicates when the print cartridge
level is low. The actual print cartridge life
remaining can vary. Consider having a
replacement cartridge available to install when
the print quality is no longer acceptable. The
print cartridge does not need to be replaced
now.

Magenta cartridge very low The print cartridge is at the estimated end of its
useful life.

Print quality might decrease. Replace the print
cartridge when the print quality becomes
unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the print
cartridge at this time unless the print quality is
no longer acceptable. The actual print cartridge
life can vary.

Once an HP print cartridge has reached the very
low threshold, the HP Premium Protection
Warranty on that print cartridge has ended. All
print defects or print cartridge failures incurred
when an HP print cartridge is used in “continue
in very low” mode will not be considered to be
defects in materials or workmanship in the
print cartridge under the HP Print Cartridge
Warranty Statement.

Replace black cartridge This alert appears only if the product is
configured to stop when the print cartridge
reaches the very low threshold. The product
indicates when a supply level is at its estimated
end of life. The actual life remaining might be
different than the estimation. Have a
replacement supply available to install when
print quality is no longer acceptable. The
supply does not need to be replaced now
unless the print quality is no longer acceptable.
After an HP supply has reached its
approximated end of life, the HP Premium
Protection Warranty on that supply ends.

Replace the specified color cartridge.

Or, configure the product to continue printing
by using the Manage Supplies menu.

Replace fuser kit The product indicates when the fuser kit is at
its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement fuser kit
available to install when print quality is no
longer acceptable. The fuser kit does not need
to be replaced now unless the print quality is no
longer acceptable. After the fuser kit reaches
its approximated end of life, the HP Premium
Protection Warranty on that fuser kit ends.

CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before handling it.

1. Open the right door.

2. Grasp the blue handles on both sides of
the fuser and pull straight out to remove
it.

3. Install the new fuser.

4. Close the right door.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Replace supplies This alert appears only if the product is
configured to stop when the print cartridges
reach the "very low" threshold. Two or more
supplies are at the estimated end of life. The
actual life remaining might be different than
the estimation. Consider having replacement
supplies available to install when print quality
is no longer acceptable. The supply does not
need to be replaced now unless the print
quality is no longer acceptable. After an HP
supply has reached its approximated end of
life, the HP Premium Protection Warranty on
that supply ends.

Replace the necessary supplies.

Or, configure the product to continue printing
by using the Manage Supplies menu.

Replace toner collection unit The product indicates when a toner collection
unit is full and needs to be replaced. Continuing
to print without replacing the toner collection
unit might cause product damage, toner spill,
or other error conditions. Have a replacement
toner collection unit available to install. After a
toner collection unit has become full, the
HP Premium Protection Warranty on that toner
collection unit ends.

Replace the toner collection unit.

Replace transfer kit The product indicates when a transfer kit is at
its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement transfer kit
available to install when print quality is no
longer acceptable. The transfer kit does not
need to be replaced now unless the print
quality is no longer acceptable. After a transfer
kit has reached its approximated end of life, the
HP Premium Protection Warranty on that
transfer kit ends.

Replace the transfer kit. Instructions are
included with the transfer kit.

Supplies in wrong position Two or more print-cartridge slots contain the
wrong color print cartridge.

From left to right, the print cartridges should
be installed in this order:

● Yellow

● Magenta

● Cyan

● Black

Install the correct color cartridge in each slot.

Supplies low This message appears when at least two
supplies have reached the low threshold. The
actual supply life remaining might vary.
Identify which supplies are low. You do not
need to replace the supplies at this time unless
print quality is no longer acceptable. After an
HP supply has reached the very low threshold,
the HP Premium Protection Warranty for that
supply has ended.

To continue printing in color, either replace the
supply or reconfigure the product by using the
Manage Supplies menu on the control panel.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Supplies very low This message appears when at least two
supplies have reached the very low threshold.
Identify which supplies are low. The actual
supply life remaining might vary. You do not
need to replace the supplies at this time unless
print quality is no longer acceptable. After an
HP supply has reached the very low threshold,
the HP Premium Protection Warranty for that
supply has ended.

To continue printing in color, either replace the
supply or reconfigure the product by using the
Manage Supplies menu on the control panel.

Toner Collection Unit Almost Full The toner collection unit is almost full. This
condition is equivalent to the supply life being
low. The actual supply life can vary. You do not
need to replace the toner collection unit at this
time.

No action is necessary to continue.

Transfer kit low This message appears when the transfer kit
reaches the low threshold. The actual supply
life remaining might vary. You do not need to
replace the transfer kit at this time unless print
quality is no longer acceptable.

No action is necessary to continue. If the print
quality is no longer acceptable, replace the
transfer kit. Instructions are included with the
new transfer kit.

Transfer kit very low This message appears when the transfer kit
has reached the very low threshold. The actual
supply life remaining might vary. You do not
need to replace the supplies at this time unless
print quality is no longer acceptable. After an
HP supply has reached the very low threshold,
the HP Premium Protection Warranty for that
supply has ended.

To continue printing, either replace the transfer
kit or reconfigure the product to continue
printing by using the Manage Supplies menu on
the control panel.

Unsupported supply installed One of the print cartridges is for a different HP
product.

If print quality is no longer acceptable, replace
the print cartridge.

Used supply in use One of the print cartridges has been previously
used.

If you believe you purchased a genuine HP
supply, go to www.hp.com/go/anticounterfeit.

Wrong cartridge in <color> slot The indicated slot for a print cartridge contains
a cartridge that is not the correct color. From
left to right, the print cartridges should be
installed in this order:

● Yellow

● Magenta

● Cyan

● Black

Remove the print cartridge from that slot, and
install a cartridge that is the correct color.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Yellow cartridge low The print cartridge is nearing the estimated end
of its useful life.

The product indicates when the print cartridge
level is low. The actual print cartridge life
remaining can vary. Consider having a
replacement cartridge available to install when
the print quality is no longer acceptable. The
print cartridge does not need to be replaced
now.

Yellow cartridge very low The print cartridge is at the estimated end of its
useful life.

Print quality might decrease. Replace the print
cartridge when the print quality becomes
unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the print
cartridge at this time unless the print quality is
no longer acceptable. The actual print cartridge
life can vary.

Once an HP print cartridge has reached the very
low threshold, the HP Premium Protection
Warranty on that print cartridge has ended. All
print defects or print cartridge failures incurred
when an HP print cartridge is used in “continue
in very low” mode will not be considered to be
defects in materials or workmanship in the
print cartridge under the HP Print Cartridge
Warranty Statement.
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Clear jams
Prevent jams

Common causes of jams1

Cause Solution

The paper length and width guides are not adjusted correctly. Adjust the guides so they are against the paper stack.

The media does not meet specifications. Use only media that meets HP specifications. See Paper and print
media on page 11.

You are using media that has already passed through a printer or
copier.

Do not use media that has been previously printed on or copied.

An input tray is loaded incorrectly. Remove any excess media from the input tray. Make sure that the
stack is below the maximum stack height mark in the tray. See
Load paper trays on page 19.

The media is skewed. The input-tray guides are not adjusted correctly. Adjust them so
they hold the stack firmly in place without bending it.

The media is binding or sticking together. Remove the media, flex it, rotate it 180 degrees, or flip it over.
Reload the media into the input tray.

NOTE: Do not fan paper. Fanning can create static electricity,
which can cause paper to stick together.

The media is removed before it settles into the output bin. Wait until the page completely settles in the output bin before
removing it.

The paper is too heavy. Do not use paper that exceeds the supported weights for the
input tray. See Supported paper types and tray capacity
on page 18.

Do not use paper that exceeds the supported weight for
automatic duplex printing. See Supported paper sizes for duplex
printing on page 17.

The media is in poor condition. Replace the media.

The internal rollers from the tray are not picking up the media. Remove the top sheet of media. If the media is too heavy, it might
not be picked from the tray. See Supported paper types and tray
capacity on page 18.

The media has rough or jagged edges. Replace the media.

The media is perforated or embossed. Perforated or embossed media does not separate easily. Load
sheets one at a time.

Paper was not stored correctly. Replace the paper in the trays. Paper should be stored in the
original packaging in a controlled environment.

1 If the product continues to jam, contact HP Customer Support or your authorized HP service provider.
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Jam locations
Use this illustration to identify locations of jams. In addition, instructions appear on the control panel to
direct you to the location of jammed paper and how to clear it.

NOTE: Internal areas of the product that might need to be opened to clear jams have green handles or
green labels.

Figure 7-1  Jam locations

2

3

5

1

4

6

1 Output bin

2 Upper right door

3 Tray 1 area

4 Tray 2, Tray 3, and optional Trays 4, 5, and 6

5 Middle right door

6 Lower right door

WARNING! To avoid electrical shock, remove any necklaces, bracelets, or other metal items before reaching
into the inside of the product.
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Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the jam
by gently pulling the paper straight out. Touch
the OK button to clear the message.

 

2. If you cannot remove the paper, or if no jammed
paper is visible in Tray 1, close Tray 1 and open
the upper right door.
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3. Gently pull the paper out of the pick up area.  

4. Close the upper right door.  
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Clear jams from Tray 2, Tray 3, or an optional tray

CAUTION: Opening a tray when paper is jammed can cause the paper to tear and leave pieces of paper in
the tray, which might cause another jam. Be sure to clear jams before opening the tray.

1. Open the tray and make sure that the paper is
stacked correctly. Remove any jammed or
damaged sheets of paper. To access jammed
paper from the tray cavity, remove the tray from
the product.

 

2. Close the tray.  

3. If the jam is in Tray 3, you also can open the door
on the right side of the tray, remove and jammed
paper, and then close the door.
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Clear jams in the upper right door

CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before handling it.

1. Open the upper right door.  

2. Gently pull the paper out of the pickup area.  

3. If paper is visible entering the bottom of the
fuser, gently pull downward to remove it.

CAUTION: Do not touch the transfer roller
(callout 1). Contaminants on the roller can affect
print quality.

 

1
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4. Paper could be jammed inside the fuser where it
would not be visible. Open the fuser jam access
door. If paper is jammed inside the fuser, gently
pull it straight up to remove it. If the paper tears,
remove all paper fragments.

CAUTION: Even if the body of the fuser has
cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they have
cooled.

If no paper is found but the product still reports a
jam, remove the fuser to check for jammed paper
inside the fuser cavity. Remove any paper, and
then reinstall the fuser.

NOTE: Make sure that the fuser is reinstalled
correctly before closing the upper right door.

 

5. Close the upper right door.  
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Clear jams in the lower right door

1. Open the lower right door.  

2. If paper is visible, gently pull the jammed paper
up or down to remove it.

 

3. Close the lower right door.  
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp the
leading edge and remove it.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies
Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using HP software The HP Embedded Web Server contains a link to the HP
SureSupply Web site, which provides options for purchasing
Original HP supplies.
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Part numbers
Ordering information and availability might change during the life of the product.

Accessories

Item Description Part number

HP Color LaserJet  1 x 500 Paper Feeder 500-sheet paper tray CE860A

HP Color LaserJet  3 x 500 Paper Feeder
and stand

1500-sheet paper tray. Contains three
500-sheet trays.

CE725A

Print cartridges

Item Description1 Part number

HP Color LaserJet black print cartridge Black cartridge CE270A

HP Color LaserJet cyan print cartridge Cyan cartridge CE271A

HP Color LaserJet yellow print cartridge Yellow cartridge CE272A

HP Color LaserJet magenta print cartridge Magenta cartridge CE273A

1 For more information, go to www.hp.com/go/learnaboutsupplies.

Cables and interfaces

Item Description Part number

Wireless Print Server HP Jetdirect 2700w USB Wireless Print
Server

J8026A

USB cable 2-meter standard USB-compatible device
connector

C6518A

Maintenance kits

Item Description Part number

Fuser kit 110 Volt replacement fuser CE977A

220 Volt replacement fuser CE978A

Transfer kit Replacement transfer belt, transfer roller
unit, 9 feed rollers for Trays 2-6, and 6
pickup rollers for Trays 1-6.

CE516A

Toner Collection Unit Receptacle for toner that has not fused to
the paper.

CE980A
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Index

A
accessories

ordering 116
part numbers 117

Administration menu, control
panel 8

AirPrint 70
anticounterfeit supplies 87
Attention light

locating 5
automatic paper sensing 29

B
bins, output

capacity 24
blank pages

placing between print jobs 68
Bonjour

identifying 82
booklets

creating (Windows) 55
printing (Mac) 59

browser requirements
HP embedded Web Server 82

buttons, control panel
locating 5

C
cable, USB

part number 117
canceling a print request (Mac OS

X) 62
canceling a print request

(Windows) 60
cartridges

non-HP 87
recycling 87
storage 87

cartridges, print
part numbers 117
replacing 88

cautions iii
cleaning

product 91
color

adjusting 73
Edge Control 73
halftone options 73
manage 71
managing 72
match 78
Neutral Grays 73
Pantone® matching 79
print color samples 78
print in grayscale 72
printed vs. monitor 78
sample book matching 78
using 71

color options
HP EasyColor (Windows) 74
setting (Mac) 77

color theme
changing, Windows 76

configurations, models 2
control panel

Administration menu 8
buttons 5
cleaning page, printing 91
lights 5
messages, numerical list 100
messages, types of 99

controlling print jobs 29
conventions, document iii
counterfeit supplies 87
cover pages

printing on different paper
(Windows) 50

D
Data light

locating 5
deleting

stored jobs 67
document conventions iii
double-sided printing

Mac 57
double-sided printing (duplexing)

loading paper 25
drivers

changing paper sizes 60
changing paper types and sizes

14
presets (Mac) 57
settings (Mac) 57
universal 32

duplex printing
Mac 57

duplex printing (double-sided)
loading paper 25
settings (Windows) 39
supported paper sizes 17

duplexing
manually (Mac) 57
manually (Windows) 41

E
Edge Control 73
Embedded Web Server (EWS)

features 82
network connection 82

envelope sizes
supported 15

envelopes
loading in Tray 1 19
loading orientation 25

error messages
control panel 99
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numerical list 100
types of 99

Explorer, versions supported
HP Embedded Web Server 82

F
features 2
file upload, Mac 83
firmware

update, Mac 84
first page

printing on different paper
(Windows) 50

fonts
upload, Mac 83

fraud Web site 87
fuser

jams 111
fuser kit

part number 117

G
graphical and text display, control

panel 5
grayscale printing 72

H
Home button 5
HP Easy Color

disabling 74
using 74

HP Embedded Web Server (EWS)
features 82
network connection 82

HP ePrint 69
HP ePrint software 69
HP fraud Web site 87
HP Universal Print Driver 32
HP Utility 83
HP Utility for Mac

Bonjour 83
features 83

HP Utility, Mac 83
HP Web Jetadmin 85

I
information pages

printing or viewing 9
installing

print cartridges 88
toner collection unit 90

Internet Explorer, versions supported
HP Embedded Web Server 82

J
jams

common causes of 106
fuser 111
locations 107
lower right door 113
output bin 114
Tray 1 108
Tray 2 110
Tray 3 110
Tray 4 110
Tray 4, 5, or 6 113
Tray 5 110
Tray 6 110
upper right door 111

Jetadmin, HP Web 85
job storage

Mac settings 66
job-separator pages 68
jobs, stored

creating (Windows) 64
deleting 67
printing 67

K
keys, control panel

locating 5

L
labels

printing (Windows) 47
printing on 23

landscape orientation
changing (Mac) 58
selecting, Windows 45

last page
printing on different paper

(Windows) 50
lights

control panel 5
loading

Tray 1 19
Tray 2 20, 22
Tray 3 20, 22
Tray 4, 5, and 6 20, 22

loading paper 19
lower right door

jams 113

M
Mac

changing paper types and sizes
14

driver settings 57
Mac driver settings

Job Storage 66
Macintosh

HP Utility 83
manual duplex

Mac 57
Windows 41

media 11
supported sizes 15

memory
included 2
supply errors 100

memory chip, toner cartridge
description 87

memory tag
locating 88

menus, control panel
Administration 8

messages
numerical list 100
types of 99

model number
location 4

models, features 2
multiple pages per sheet

printing (Mac) 58
printing (Windows) 43

N
Netscape Navigator, versions

supported
HP embedded Web Server 82

networks
HP Web Jetadmin 85
print servers included 2

Neutral Grays 73
non-HP supplies 87
notes iii

O
ordering

part numbers for 117
supplies and accessories 116

orientation
changing (Mac) 58
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paper, while loading 25
selecting, Windows 45

output bin
jams 114

P
page orientation

changing (Mac) 58
page sizes

scaling documents to fit (Mac)
59

scaling documents to fit
(Windows) 53

pages per sheet
selecting (Mac) 58
selecting (Windows) 43

paper
covers, using different paper 50
first and last pages, using

different paper 50
load 19
loading orientation 25

paper jams
common causes of 106
locations 107

paper path
cleaning 91

paper size
changing 14, 60

paper sizes
selecting (Mac) 62
selecting custom sizes (Mac) 62
selecting custom sizes

(Windows) 61
supported 15
supported for duplex 17

paper type
selecting (Windows) 47

paper types
changing 14
selecting (Mac) 58
supported 18

paper, covers
printing (Mac) 58

paper, ordering 116
part numbers

list of 117
print cartridges 117

PCL drivers
universal 32

portrait orientation
changing (Mac) 58
selecting, Windows 45

power
troubleshooting 97

presets (Mac) 57
print cartridge

managing 86
print cartridges

part numbers 117
replacing 88

print drivers
supported 32

print drivers (Mac)
settings 57

print media
loading in Tray 1 19

print on both sides
Mac 57
Windows 41

print tasks 31
printing

settings (Mac) 57
stored jobs 67

printing on both sides
settings (Windows) 39

problem-solving
messages, types of 99

product info 1

R
Ready light

locating 5
recycling supplies 87
resize documents

Mac 59
Windows 53

S
scale documents

Mac 59
Windows 53

self help
accessing 96

serial number
location 4

settings
driver presets (Mac) 57

shortcuts (Windows)
creating 36
using 34

software
HP Utility 83

special media
guidelines 12

special paper
guidelines 12
printing (Windows) 47

special paper for covers
printing (Mac) 58

status
HP Utility, Mac 83
messages, types of 99

Stop button 5
stopping a print request (Mac OS X)

62
stopping a print request (Windows)

60
storage, job

Mac settings 66
stored jobs

creating (Mac) 66
creating (Windows) 64
deleting 67
printing 67

storing
toner cartridges 87

storing jobs
with Windows 64

supplies
counterfeit 87
memory errors 100
non-HP 87
ordering 116
part numbers 117
recycling 87
replacing 88
status, viewing with HP Utility for

Mac 83
supported paper 15
system requirements

HP Embedded Web Server 82

T
tips iii
toner cartridges

memory chips 87
non-HP 87
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recycling 87
storage 87

toner collection unit
replacing 90

transfer kit
part number 117

transparencies
automatic sensing 29
printing (Windows) 47

trapping 73
Tray 1

automatic paper sensing 29
capacity 24
jams 108

Tray 2
capacity 25
jams 110

trays
capacity 24
configure 28
included 2
load 19
paper orientation 25

troubleshooting
checklist 97
control panel messages 99
error messages, numerical list

100
two-sided printing

settings (Windows) 39

U
universal print driver 32
upper right door

jams 111

W
warnings iii
watermarks

printing (Mac) 62
printing (Windows) 61

Web browser requirements
HP Embedded Web Server 82

Web sites
fraud reports 87
HP Web Jetadmin, downloading

85
universal print driver 32

Windows
changing paper types and sizes

14
universal print driver 32

Windows print drivers
supported 32
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